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AMC Activity Listings 

Application: An 

Overview 

The Appalachian Mountain Club has developed a searchable online activity listings database for 

use by staff and volunteers. The purpose of this application is to present a universal set of 

searchable upcoming AMC events and volunteer opportunities regardless if sponsored by 

volunteer committees or staff. The system also automates the process for volunteer committees 

submitting their trips to AMC Outdoors for inclusion in Backcountry, while at the same time 

making trips eligible for publication on the AMC website, activities.outdoors.org. Volunteer 

newsletter editors and webmasters may also extract data from the system to feed their websites 

and print publications. 

The application offers a workflow that allows volunteer committees to create an electronically 

managed approval process based on the following structure: 

o Contributors (trip leaders, trail event organizers) input their trips/volunteer 

opportunities into a web-based form.  

o Trips/volunteer opportunities are then sent to an appropriate volunteer Reviewer within 

the contributer’s committee.  

o Once reviewed and approved by the committee Reviewer, the trip is passed to the 

appropriate volunteer committee Approver, who makes any final edits and approves the 

trip on behalf of the committee.  

o Trips then get published on the web and are queued for inclusion in upcoming issues of 

AMC Outdoors; they are also available for inclusion in volunteer newsletters and 

websites.  

o While trips and volunteer opportunities are not subject to approval by AMC staff, AMC 

staff may periodically review listings for quality and edit as needed. 

 

Chapter and volunteer committee leaders determine the best workflow for their committees 

within this structure (illustrated on the next page). If you would like to learn more about how 

your committee’s approval process works check in with your committee chair. 
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AMC Outdoors

Online Chapter Activity Workflow

Contributor

Submits new trip listing 

Can retrieve any old trip 

archived by committee

•One or more per chapter 

committee (trip leaders or 

committee coordinator)

•Rights: 

• can modify or delete 

own listings until 

submitted for approval

Reviewer

Reviews all pending chapter 

contributor listings and 

accepts or edits

•Ideally one per committee 

(e.g. committee chair)

•An individual can be both a 

contributor and an approver 

at chapter’s discretion

•Rights: 

•Creates or deletes 

contributor accounts 

for committee

•Approves trips 

submitted by 

contributors for 

committee.

•Can directly add new 

trips at any time.

Approver

Reviews, edits and approves 

for publication all pending 

chapter listings

•Ideally one per chapter (e.g. chapter 

coordinator) but also can be 

committee-specific

Rights:

•Creates or deletes reviewer accounts

•Approves trips approved by reviewers

•Can directly add new trips & edits               

live trips for chapter at any time

Trip Listing

Database

AMC Outdoors Editor

•Can edit, add, delete listings

•Can edit, add, delete listings

Chapter Newsletter Editors

& Webmaster

•Can access text file or online 

listings once through chapter 

approval process

Chapter Newsletters

www.outdoors.org

Chapter Websites

Change trip status

New listings 

and major 

changes

•Note: an individual may play multiple roles

•Major Excursions is managed as separate “chapters” in the system

AMC Web Editor



 

 v 2.0 5

System Requirements 

The  application has been developed such that it is compliant with the following operating 
systems: 
XP, Vista, Windows 7 
Mac OS X 10.4.11 or better 
The system is compliant with the following browsers (all latest versions; older versions may 
also work, but have not been tested extensively): 
Firefox 2.0+ 
Internet Explorer 7.0+ 
Safari 3.0+ 
Google Chrome 
Opera 9.5+ 
 
Users should also note that in order to use the system, Javascript and cookies must 
be enabled. To do this, reference directions for your browser below. 
 
Internet Explorer 
To enable Javascript in Internet Explorer: 
 
   1. Click the Tools menu. 
   2. Select Internet Options. 
   3. Click the Security tab. 
   4. Click the Custom Level button. 
   5. Scroll down until you see the 'Scripting' section. Select the 'Enable' radio button for 
'Active Scripting.' 
   6. Click the OK button. 
   7. If you see a confirmation window, click the Yes button. 
 
To enable cookies in Internet Explorer 7 or 
8: 
 
   1. Click Start > Control Panel. (Note: 
with Windows XP Classic View, click the 
Windows Start button > Settings > Control 
Panel). 
   2. Double-click the Internet Options icon. 
   3. Click the Privacy tab. 
   4. Click the Advanced button. 
   5. Select the option 'Override automatic 
cookie handling' under the Cookies section in 
the Advanced Privacy Settings window. 
   6. Select the 'Accept' or 'Prompt' option 
under 'First-party Cookies.' 
   7. Select the 'Accept' or 'Prompt' option 
under 'Third-party Cookies.' (Note: if you 
select the 'Prompt' option, you'll be 
prompted to click OK every time a website 

To enable cookies in Internet Explorer 6: 
 
   1. Click Start > Control Panel. (Note: 
with Windows XP Classic View, click the 
Windows Start button > Settings > Control 
Panel). 
   2. Click the Advanced button. 
   3. Select the option 'Override Automatic 
Cookie Handling.' 
   4. Select the 'Accept' or 'Prompt' option 
under 'First-party Cookies.' 
   5. Select the 'Accept' or 'Prompt' option 
under 'Third-party Cookies.' (Note: if you 
select the 'Prompt' option, you'll be 
prompted to click OK every time a website 
attempts to send you a cookie.) 
   6. In the Internet Options window, click 
OK to exit. 
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attempts to send you a cookie.) 
   8. In the Internet Options window, click 
OK to exit. 
 
 
Firefox 
To enable Javascript in Firefox: 
   1. Click the Tools menu. 
   2. Select Options. 
   3. Click the Content tab. 
   4. Select the 'Enable JavaScript' checkbox. 
   5. Click the OK button. 
 
To enable cookies in Firefox 3.x (PC): 
 
   1. Click Tools > Options. 
   2. Click Privacy in the top panel. 
   3. Set 'Firefox will': to Use custom settings 
for history. 
   4. Check the box next to Accept cookies 
from sites to enable cookies, or uncheck it to 
disable them. 
   5. Click OK. 
 
 
To enable cookies in Firefox 2.x (PC): 
 
   1. Click Tools > Options. 
   2. Click Privacy in the top panel. 
   3. Select the checkbox labeled 'Accept 
cookies from sites.' 
   4. Click OK. 
 
 
Chrome 

To enable cookies in Firefox (Mac): 
 
   1. Go to the Firefox drop-down menu. 
   2. Select Preferences. 
   3. Click Privacy. 
   4. Set 'Firefox will': to Use custom settings 
for history. 
   5. Check the box next to Accept cookies 
from sites to enable cookies, or uncheck it to 
disable them. 
   6. Click OK.  

 

Note: JavaScript is enabled by default in Chrome. 
 
 
To enable cookies in Chrome (PC): 
 
   1. Click the Tools menu. 
   2. Select Options. 
   3. Click the Under the Hood tab. 
   4. Click Content settings in the 'Privacy' 
section. 
   5. Make sure Allow local data to be set is 
selected to allow both first-party and third-
party cookies. For any given webpage, first-
party cookies are cookies that are set by the 

To enable cookies in Chrome (Mac): 
 
   1. Select Chrome > Preferences on the 
menu bar. 
   2. Click the Under the Hood tab. 
   3. Click Content settings in the 'Privacy' 
section. 
   4. Make sure Allow local data to be set is 
selected to allow both first-party and third-
party cookies. For any given webpage, first-
party cookies are cookies that are set by the 
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site domain listed in the address bar. Third-
party cookies come from other domain 
sources that have items, such as ads or 
images, embedded on the page. If you only 
want to accept first-party cookies, check the 
box next to Block all third-party cookies 
without exception. 
 
 

site domain listed in the address bar. Third-
party cookies come from other domain 
sources that have items, such as ads or 
images, embedded on the page. If you only 
want to accept first-party cookies, check the 
box next to Block all third-party cookies 
without exception. 
 

 
Safari 
To enable Javascript in Safari: 
   1. Click the Safari menu. 
   2. Select Preferences. 
   3. Click the Security tab. 
   4. Select the 'Enable JavaScript' checkbox. 
 
To enable cookies in Safari: 

� Select Preferences from the Safari menu.  
� Click Security.  
� Under Accept Cookies, click Always.  
� Close the window.  
� Click Reload. 

 
 
Opera 
To enable Javascript in Opera (all versions): 

� Select Quick Preferences from the File menu.  
� Make sure Enable Javascript is checked.  
� Click Reload.  

 
To enable cookies in Opera: 

� Select Preferences from the Tools menu.  
� Click Privacy.  
� Ensure both Enable cookies and Accept cookies normally are checked. 
� Click OK. 
� Close the window.  
� Click Reload. 
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Logging In 

To log into the system, go to: http://activities.outdoors.org/login using your 

current login information (current email address and password supplied to you 

by your chapter administrator). 

 

 

Upon logging in, you’ll find several options 

available, including the ability to add a new 

trip/volunteer opportunity, update/change your 

user information, and ability to access trips 

based on several different search parameters. A 

description of each of these functions will be 

included in subsequent sections of this guide.

Forgot your password? Use 
the “Forgot your password?” link to 
the right of the password box to 
request an email with your login 
information be sent to your email 
address. 
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Account Administration: Changing Your Contact 

Information, Password, and User Defaults 

The application allows users, at any time, to edit their contact information (email 

address), change their password, and set default values for personal information 

that is often requested in the trip entry form. To do so, log in to the system at 

http://activities.outdoors.org/login using your current login information (email 

address and password). 

 

 

Once logged in, you’ll find a central contributor administration area, that will 

give you several options, including the ability to update your account 

information, add trips and/or volunteer opportunities, change the status of 

existing trips (to indicate a trip is full, cancel a trip, etc.), and search current and 

archived trips. 
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Select “My Account” in the left navigation bar to be directed to the account 

information administration page. 
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In this form, you are able to easily edit your first & last names, phone number, 

email address and password. To change your password, enter your new desired 

password in the “*Password” field and then re-type it in the “*Confirm 

Password” field. Please note: current guidelines for passwords are fairly basic – a 

recommended password would be at least 6 characters long & alphanumeric, 

however the system won’t disqualify most passwords – its only current 

restriction is that passwords be less than 50 characters in length.  

 

In the “User Defaults” box on this page, you may also set default values for each 

of the values available; doing so will pre-populate these fields on the trip entry 

form in the future and help reduce the amount of time required to enter a trip. 

Note: You may always override your default values for a specific event on the trip entry 

form when entering the event. 

 

User 

Defaults 

Defined 

What is this? What do I enter? 

Phone Trip contributor/leader phone 

number 

Enter the phone number with 

which you’d most often like 

prospective trip participants to 
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User 

Defaults 

Defined 

What is this? What do I enter? 

contact you. 

Call Time Best time to call trip 

contributor/leader 

Enter the time(s) of day you 

most often prefer to receive 

phone calls from prospective 

trip participants. 

Phone on 

Web 

Flag to indicate if trip 

leader/trip contributor phone 

number is to be visible on the 

web. 

Check this if you’d like your 

phone number to be visible on 

many or all of your trip 

listings. 

Email on 

Web 

Flag to indicate if trip 

leader/trip contributor email 

address is to be visible on web. 

Check this if you’d like your 

phone number to be visible on 

many or all of your trip 

listings. Note: entering your 

email address and leaving this 

box unchecked will give users 

the options to email you 

anonymously via an online 

contact form. 

Registration Radio button to indicate if 

registration is required or not 

required for trip 

leader/contributors’ trips. 

Select the registration option 

that most often applies to your 

trips. 

Listing Type Radio button to indicate where 

trip will be posted. Web only 

means the trip will not be listed 

in AMC Outdoors. Magazine 

only means the trip will not be 

made available to AMC 

websites, including volunteer-

managed sites (e.g. chapter 

website.) 

Select the publication option 

that most often applies to your 

trips. 

Location Freeform text box to indicate, 

specifically, where your trip 

takes place. Entering a value in 

this field is helpful only if you 

frequently lead/enter trips that 

take place in the same location 

Enter the location where you 

most frequently lead your 

trips. E.g. Blue Hills 

Reservation, Valley Forge 

National Park, Central Park. 
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User 

Defaults 

Defined 

What is this? What do I enter? 

(e.g. a specific state park, town, 

etc.) 

Audience Dropdown box to indicate for 

what audience your trips are 

typically geared. Entering a 

value in this field is helpful only 

if you frequently lead/enter trips 

that are restricted to a particular 

demographic (families, ages 50+, 

etc.) This value helps end users 

search on programs/trips 

specifically geared to their 

demographic. 

Select the appropriate option 

from the dropdown box. 

Activity Dropdown box to indicate what 

activity is best and most 

frequently associated with the 

trip leader/contributor’s trips. 

Select the activity that is most 

relevant to the majority of 

your trips. E.g., if you are a 

hiking leader, you might select 

hiking. A biking committee 

leader might select biking. 

Nearby 

AMC 

Destination 

Dropdown box to indicate that a 

trip leader regularly leads trips 

near an AMC Destination. This 

value helps end users search on 

programs/trips taking place 

near an AMC Destination, 

where they may be planning a 

trip. A good use of this default 

field would be for trip leaders 

who regularly lead trips at or 

near Mohican Outdoor Center, 

for example. 

Select the AMC Destination 

near which you most 

frequently lead trips, if any. 

Region Dropdown box to indicate that a 

trip leader regularly leads trips 

in a particular geographic 

region. This value helps end 

users search on programs/trips 

taking place in a particular 

Select the region in which you 

most frequently lead trips, if 

any. 
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User 

Defaults 

Defined 

What is this? What do I enter? 

region. A good use of this 

default field would be for trip 

leaders who regularly lead hikes 

in the White Mountains, for 

example. 

State Dropdown box to indicate that a 

trip leader regularly leads trips 

in a particular state. This value 

helps end users search on 

programs/trips taking place in a 

particular state 

Select the state in which you 

most frequently lead trips, if 

any. 

 

In the lowest section of this page, your user access settings are visible for review. 

This section will indicate to which volunteer committees you have access and at 

what level. For trip contributors, this section is for your reference only and may 

not be edited. If you notice an error in this area, contact your volunteer 

committee administrator to assist with changes to your account access. 

 

Other notes:  

� The contact information (email address, phone number) listed in your 

user account information is for administrative use only and will not be 

made public through this system unless you indicate phone and/or email 

address should be published on the web for a particular trip. 

� The “Cancel” button will abandon any and all changes you make to the 

page and bring you back to the central contributor administration area. 

� The “Clear Changes” button can be used to clear the entire form and 

revert to the form’s original state when you opened it (retaining values 

that may have existed prior to your most recent edits).  

Make your desired changes on this form and click the “Review” button to submit 

your changes. Note – the “Review” button does not save your changes; it brings 

you to a confirmation screen, where you must review your edits and click 

“Save” to complete the submission process. If you note errors or omissions on 

the confirmation screen, use the “Edit” button to return to the account update 

form. 
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Entering a New Trip 

Listing 

To begin entering trips, you must first log in (if you’re not logged in already), 

using your email address and assigned password: 

 

 

Once logged in, you’ll find a central contributor administration area, that will 

give you several options, including the ability to update your account 

information, add trips and/or volunteer opportunities, change the status of 

existing trips (to indicate a trip is full, cancel a trip, etc.), and search current and 

archived trips. 



 

 v 2.0 16 

 

To enter a trip, select “Add Chapter Trip” in the left navigation bar. 

You will be taken to the trip entry screen, illustrated here: 
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The trip entry process is done completely through this web-based form, which is 

similar to an online email form or online shopping. Please note that only those 

fields marked with an asterisk are required. All other fields are optional. 

 

A complete breakdown of all fields on the form with descriptions and rules for 

each are as listed in the following table. Please use this table to populate the 

form. 

 

 

Trip Entry 

Form Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

Event Type Indicates what type of 

trip is being entered. 

Options include 

“Chapter Trip” or 

“Volunteer 

Opportunity.”  

Nothing. This field is 

pre-defined based on 

what type of 

trip/program you opted 

to enter in the left 

navigation. 

Yes 

Program 

Fees 

Optional, separate form 

fields to use for any fees 

associated with the trip. 

You may enter one rate 

for adult members and 

one rate for adult non-

members. Any additional 

rate information may be 

detailed in the Trip 

Description fields. 

Adult member rate and 

adult non-member rate, 

if applicable. 

No 

Group Indicates who is 

sponsoring this trip. 

Options include each 

AMC Chapter, AMC 

Staff, and other volunteer 

committees. 

Nothing. This field is 

pre-defined based on 

your account access and 

volunteer affiliation. 

Yes 

Managed by Indicates which “sub-

group” (or committee) is 

sponsoring this trip. 

Options are available in 

the dropdown box, based 

on your account access 

and volunteer 

Select the committee or 

group from the 

dropdown menu on 

whose behalf you are 

leading/entering the 

trip. 

Yes 
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Trip Entry 

Form Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

affiliations. 

Status Indicates current status 

of the trip; options 

include “Open,” “Full,” 

“Wait List,” or 

“Cancelled” 

Select the current status 

of the trip; note the 

system defaults this 

value to “Open” so you 

may not need to take 

action. You may update 

this status field at any 

time. 

Yes 

Listing Type Radio button to indicate 

where trip will be posted. 

“Web only” means the 

trip will not be listed in 

AMC Outdoors. 

“Magazine only” means 

the trip will not be made 

available to AMC 

websites, including 

volunteer-managed sites 

(e.g. chapter website). 

Select the publication 

option that applies to 

your trip. 

Yes 

Title Trip title. This title will 

appear in the web search 

results (as a clickable link 

to the full description of 

the trip) and bolded in 

the Backcountry section 

of AMC Outdoors. Title 

character limit is 250 

characters. 

Enter a short, 

descriptive title for your 

trip. If your chapter 

typically does so, you 

might also indicate the 

trip’s difficulty rating in 

parentheses at the end 

of this field. E.g. 

“Fairmount Park Loop 

Hike (3AB10)” 

Yes 

Dates Trip dates. You may also 

use this area to indicate 

that a trip is recurring. 

Note: Indicating that a 

trip is “recurring” means 

that, upon submission, 

the trip will break out 

Single-day trips: Enter 

trip date in first date 

box. Second date box  

(“end date”) will auto-

populate with the same 

date. 

Multi-day trips: Enter 

Yes 
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Trip Entry 

Form Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

into multiple listings – 

one for each date on 

which the trip recurs. 

trip start date in first 

date box. Enter trip end 

date in second date box. 

Recurring trips (e.g. 

every Wednesday for a 

given month): Enter 

start date of recurring 

date range in first date 

box. Enter end date of 

recurrent date range in 

second date box. In 

middle select box, select 

on which day of the 

week the recurring trip 

takes place. E.g. a 

recurring trip on 

Mondays in March 

would use start date of 

3/1/XX and end date of 

3/31/XX and the middle 

select box would be 

highlighted with 

“Mondays only” 

Magazine 

Issue(s) 

This display field 

indicates when your trip 

will appear in AMC 

Outdoors, based on the 

trip dates and any special 

designations (e.g. 

Advance Notice) placed 

on the trip. 

No action required. Use 

this display field to 

confirm when your trip 

will appear in the 

magazine. 

N/A 

Registration Radio button to indicate 

if registration is required 

or not required for trip 

leader/contributors’ trips. 

Note that your selection 

will impact how many 

words are available to 

Select the registration 

option that applies to 

this trip. 

Yes 
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Trip Entry 

Form Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

you in the magazine 

description field (longer 

entries are allowed when 

registration is not 

required.) 

Archive on 

Expiration? 

This checkbox allows you 

to submit your trip to the 

archives for two years 

once it occurs. This 

means that you can 

retrieve and reactivate it 

in the future (re-activate 

it and update the dates). 

This is helpful if you run 

the same or a similar trip 

every year. 

The system default-

checks this box. If you 

do not wish this trip to 

be archived, uncheck 

the box. 

 

Backcountry 

Designations 

These checkboxes allow you to designate your trip 

for special treatment in Backcountry and, in some 

cases, online.  

Clubwide Events allows you to place your trip’s full 

listing in the “Clubwide Events” section of 

Backcountry. Choosing this option also means that 

under your chapter/committee listings, the trip title 

will appear and a note will direct readers to 

Clubwide Events for the full description. 

“Cross-reference in Clubwide Events” allows you to 

keep your trip’s full listing under your 

chapter/committee listings; it will also include the 

trip title under “Clubwide Events” and a note will 

direct readers to your chapter/committee listings for 

full details. 

“Advance Notice” allows you to submit a trip for 

inclusion in the magazine one issue earlier than 

guidelines would typically allow. Use this option 

only if your trip requires a $$ deposit.  

“Special Notice” allows your trip to display at the 

beginning of your chapter’s trip listings in 

Backcountry under a “Special Notice” heading. 
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Trip Entry 

Form Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

 

Short Web 

Description 

You may opt to skip this 

field if you like. Use of 

this description field is 

currently limited to the 

search results page for 

end web users. Hovering 

over a trip title will 

display this field. 

You may opt to skip this 

field. If you choose to 

populate it, enter a short 

summary of the trip. 

Word limit is 100 words. 

No 

Long Web 

Description 

This description of the 

trip is displayed on the 

web – both on chapter 

websites and on the main 

AMC website. 

Enter up to 450 words 

describing the trip. 

Yes, if trip 

is set to be 

published 

on web. 

Magazine 

Description 

This description of the 

trip is displayed in AMC 

Outdoors and is available 

for use by volunteer 

newsletter editors for 

their publications. 

Enter up to 20 words 

describing the trip. If 

registration is not 

required, you may enter 

40 words. If trip is 

marked “Advance 

Notice,” you may enter 

60 words. If you exceed 

the prescribed limit you 

will be informed when 

you click away from the 

field. 

Yes, if trip 

is set to be 

published 

on web. 

Location Freeform text box to 

indicate, specifically, 

where your trip takes 

place. Entering a value in 

this field is usually 

helpful only if the trip 

takes place in a specific 

location or town that is 

distinct from the 

“Region” 

Enter the location where 

the trip takes place. E.g. 

Blue Hills Reservation, 

Valley Forge National 

Park, Central Park. 

No 

Difficulty Freeform text box to Enter the trip’s level of No 
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Trip Entry 

Form Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

advertise the trip’s 

difficulty level 

(alphanumeric code for 

some chapters; “Easy,” 

“Intermediate,” 

“Advanced,” for others, 

for example) 

difficulty based on your 

chapter’s standards. 

Region This dropdown value 

helps end users search on 

programs/trips taking 

place in a particular 

region.  

Select the region in 

which the trip takes 

place. 

Yes 

State This dropdown box sets a  

value that helps end 

users search on 

programs/trips taking 

place in a particular state 

This field auto-

populates based on your 

selection of a Region. If 

necessary, select the 

state in which the trip 

takes place. 

Yes 

Country This box displays the 

country in which the trip 

occurs. 

This field auto-

populates based on your 

selection of a Region. If 

necessary, enter the 

country in which the 

trip takes place. 

Yes 

Nearby 

AMC 

Destination 

This dropdown box sets a 

value that helps end 

users search on 

programs/trips taking 

place near an AMC 

Destination, where the 

end user may be 

planning a trip.  

Select the AMC 

Destination near which 

the trip occurs, if any. 

You may select multiple 

entries from this list by 

holding the “Ctrl” 

button down while 

selecting multiples.  

No 

Activity Dropdown box to 

indicate what activity is 

best associated with the 

trip. End web users will 

use these activities when 

Select the activity that is 

most relevant to your 

trip. You may select 

multiple entries from 

this list by holding the 

Yes 
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Trip Entry 

Form Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

searching to find trips 

that fit their activity 

interests. 

“Ctrl” button down 

while selecting 

multiples. 

Contact 

Information 

- Name 

This field displays the 

name of the trip leader 

on the web and in the 

magazine. 

Enter trip leader name 

(the field auto-populates 

with trip contributor’s 

name – no action may 

be necessary). Note that 

Contact Information 

Row #1 is required so at 

least one leader’s name 

must be entered. 

Yes – Row 

1 only 

Contact 

Information 

– Phone 

Number 

This field accepts a single 

phone number. If 

populated, the phone 

number will be printed in 

the magazine. The phone 

number will not be 

displayed on the web 

unless “Show Phone on 

Web” checkbox is 

checked (see below.) 

Enter trip leader’s 

phone number. 

Not if 

email 

address is 

entered 

instead – 

Row 1 only 

Contact 

Information 

– Time to 

Call 

Best time to call trip 

contributor/leader. If 

populated, the time to 

call will be printed in the 

magazine. Times to call 

will not be displayed on 

the web unless “Show 

Phone on Web” checkbox 

is checked (see below.) 

Enter the time(s) of day 

trip leader prefers to 

receive phone calls from 

prospective trip 

participants. 

No 

Contact 

Information 

– Show 

Phone on 

Web 

Flag to indicate if trip 

leader phone 

number/times to call is to 

be visible on the web. 

Check this if you’d like 

the phone number/times 

to call fields to be visible 

on the web. 

Not if 

email 

address is 

entered 

instead – 

Row 1 only 
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Trip Entry 

Form Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

Contact 

Information 

– Email 

Address 

This field accepts a single 

email address. If 

populated, the email 

address will be printed in 

the magazine. The email 

address will not be 

displayed on the web 

unless “Show Email on 

Web” checkbox is 

checked (see below.) If 

email address is entered 

and “Show Email on 

Web” is NOT checked, 

end web users may still 

contact trip leader via an 

anonymous web contact 

form. 

Enter trip leader’s email 

address (the field auto-

populates with trip 

contributor’s email 

address – no action may 

be necessary). 

Not if 

phone 

number is 

entered 

AND 

“Show 

Phone on 

Web” is 

checked – 

Row 1 only 

Contact 

Information 

– Show 

Email on 

Web 

Flag to indicate if trip 

leader email address is to 

be visible on web. 

Check this if you’d like 

your email address to be 

visible to web users. 

Note: If email address is 

entered and “Show 

Phone on Web” is NOT 

checked, end web users 

may still contact trip 

leader via an 

anonymous web contact 

form. 

Not if 

phone 

number is 

entered 

AND 

“Show 

Phone on 

Web” is 

checked – 

Row 1 only 

Co-Contact 

Information 

Please refer to “Contact Information” information above for 

details on populating these fields with co-leader information. 

Registrar Please refer to “Contact Information” information above for 

details on populating these fields with Registrar information. If 

this information is populated, then “Registrar” will be displayed 

first on the web to indicate that they are the primary point of 

contact for the trip. Enter Address, City, State and ZIP if you are 

encouraging trip participants to send a check to the Registrar via 

U.S. Mail. This information will be published in the magazine and 

on the web. 
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Trip Entry 

Form Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

Website 

Posting 

Information 

– Web 

Release Date 

This field controls when 

your trip will be 

published live on the 

web once it passes 

approval. E.g. You may 

submit an August trip 

during May, in which 

case it will be approved 

almost immediately. If 

you do not wish your 

trip to be available on the 

web until June, you’d 

enter 6/1/XX in this field. 

Enter the date you’d like 

the trip to appear on the 

web if not immediately. 

This field auto-

populates with today’s 

date, so no action may 

be necessary. 

No 

Web End 

Date 

This field controls when 

your trip will be 

removed from the web. 

Note trips are removed 

from the web the day 

after they take place by 

default. E.g. For a trip 

taking place on 6/15/XX, 

you may wish to have 

the trip removed from 

the web on 6/10/XX to 

discourage last-minute 

signups. 

Enter the date you’d like 

the trip to be removed 

from the web, if at all. 

By default, the trip will 

be removed the day 

after it takes place. 

No 

Web Search 

Terms 

This field allows you to 

enter some key words or 

terms relevant to the trip 

that might help search 

engines “find” it and 

feature it in search result 

listings. 

Enter a handful of 

relevant keywords or 

phrases. Anything 

already included in 

your description need 

not be repeated here. 

No 

Link Text This field, in combination with “Link URL” allows 

you to add related links to your listing. Populate the 

link text field with a descriptive title for the link. 

E.g. “More Information on Blue Hills Reservation” 

You may add up to 6 related links. 

No 
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Trip Entry 

Form Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

Link URL This field, in combination with “Link Text” allows 

you to add related links to your listing. Populate the 

link URL field with the URL to which you’d like to 

direct web users for more information (minus the 

“http://”). E.g. 

“www.mass.gov/dcr/parks/metroboston/blue.htm 

You may add up to 6 related links. 

No 

Notes This field allows you to send internal, 

administrative notes to other volunteer committee 

users in your approval queue. When your reviewer 

opens the trip for review, they will be able to see 

your notes. 

No 
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When you have completed data entry, click “Review” to move on to a 

confirmation screen. 
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Review the confirmation screen for accuracy. Use the “Edit” button to return to 

the trip entry screen to make changes. 

 

Contributors are also given the option to “Save/Edit Later” or “Submit & 

Forward to Reviewer”.  If you submit your trip, the reviewer will be 

automatically notified by email that your trip is waiting for review. Contributors 

have the ability to edit their trips up until the point a reviewer edits and 

approves the trip (see “Editing a Trip Listing Prior to Approval” on page 49 for 

additional detail on this). Once a reviewer has opened a trip to edit, that trip is 

no longer accessible to contributors for editing. 

 

After submitting one trip, you will return to the previous screen and see your 

new listing under “Current Events” with a status of “Contributor sent to 

Reviewer”.  You can also see the status of your other submissions.  Once your 

trip has gone through the complete review process by committee reviewer and 

chapter approver, the trip will be posted to the website and/or published in the 

magazine, based on your specifications. 

 

Note also that next to each trip under “Current Trips,” several options, including 

“View Mag,” “View Web” and “Edit” exist.  

 

 
 

The “view mag” button allows you to preview the trip the way it will be 

submitted to the AMC Outdoors editors.  
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E.g. 

  
 

The “view web” button allows you to preview the trip the way it will appear 

online once approved.  

 

E.g.  
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The “edit” button will allow you to re-open the trip entry form to make any 

changes prior to the trip being reviewed. Please note that if your trip is 

“recurring” you’ll need to edit each instance of the trip. 

 

Entering a New Volunteer 

Opportunity 

To begin entering trips, you must first log in (if you’re not logged in already), 

using your email address and assigned password: 

 

 

Once logged in, you’ll find a central contributor administration area, that will 

give you several options, including the ability to update your account 

information, add trips and/or volunteer opportunities, change the status of 

existing trips (to indicate a trip is full, cancel a trip, etc.), and search current and 

archived trips. 
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To enter a trip, select “Add Volunteer Opportunity” in the left navigation bar. 

You will be taken to the volunteer opportunity entry screen, illustrated here: 
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The volunteer opportunity entry process is done completely through this web-

based form, which is similar to an online email form or online shopping. Please 

note that only those fields marked with an asterisk are required. All other fields 

are optional. 

 

A complete breakdown of all fields on the form with descriptions and rules for 

each are as listed in the following table. Please use this table to populate the 

form. 

 

 

Trip Entry 

Form 

Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

Event Type Indicates what type of trip is 

being entered. Options 

include “Chapter Trip” or 

“Volunteer Opportunity.”  

Nothing. This field is 

pre-defined based on 

what type of 

trip/program you 

opted to enter in the 

left navigation. 

Yes 

Group Indicates who is sponsoring 

this trip. Options include 

each AMC Chapter, AMC 

Staff, or other volunteer 

committees. 

Nothing. This field is 

pre-defined based on 

your account access 

and chapter 

affiliation. 

Yes 

Managed 

by 

Indicates which “sub-group” 

(or committee) is sponsoring 

this opportunity. Options are 

available in the dropdown 

box, based on your account 

access and volunteer 

committee affiliations. 

Select the committee 

or group from the 

dropdown menu on 

whose behalf you are 

leading/entering the 

opportunity. 

Yes 

Status Indicates current status of 

the opportunity; options 

include “Open,” “Full,” 

“Wait List,” or “Cancelled” 

Select the current 

status of the 

opportunity; note the 

system defaults this 

value to “Open” so 

you may not need to 

take action. You may 

update this status 

field at any time. 

Yes 
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Trip Entry 

Form 

Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

Listing 

Type 

Radio button to indicate 

where trip will be posted. 

“Web only” means the 

opportunity will not be listed 

in AMC Outdoors. “Magazine 

only” means the opportunity 

will not be made available to 

chapter/AMC websites. 

Select the publication 

option that applies to 

your opportunity. 

Yes 

Title Volunteer opportunity title. 

This title will appear in the 

web search results (as a 

clickable link to the full 

description of the trip) and 

bolded in the Backcountry 

section of AMC Outdoors. 

Title character limit is 250 

characters. 

Enter a short, 

descriptive title for 

your opportunity.  

Yes 

Dates Dates during which this 

opportunity will be 

available. You may also use 

this area to indicate that an 

opportunity is recurring or 

will be “run into filled”. 

Single-day 

opportunities/events: 

Enter date in first 

date box. Second 

date box  (“end 

date”) will auto-

populate with the 

same date. 

Multi-day 

opportunities/events: 

Enter start date in 

first date box. Enter 

end date in second 

date box. 

Recurring trips (e.g. 

every Wednesday for 

a given month): 

Enter start date of 

recurring date range 

in first date box. 

Yes 
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Trip Entry 

Form 

Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

Enter end date of 

recurrent date range 

in second date box. 

In middle select box, 

select on which day 

of the week the 

recurring trip takes 

place. E.g. a 

recurring 

opportunity on 

Mondays in March 

would use start date 

of 3/1/XX and end 

date of 3/31/XX and 

the middle select box 

would be 

highlighted with 

“Mondays only” 

To submit an 

opportunity as “Run 

until filled” 

(meaning it’s open 

until you mark it 

“filled”) enter a start 

date and click the 

“run until filled” 

checkbox. 

Magazine 

Issue(s) 

This display field indicates 

when your trip will appear 

in AMC Outdoors, based on 

the trip dates and any special 

designations (e.g. Advance 

Notice) placed on the trip. 

No action required. 

Use this display field 

to confirm when 

your trip will appear 

in the magazine. 

N/A 

Duration This dropdown field sets a 

value that end web users 

will use to search for 

volunteer opportunities. For 

Select the 

appropriate choice 

from the dropdown 

box. 

No 
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Trip Entry 

Form 

Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

instance, a user may indicate 

they have a day to spend 

volunteering and would like 

to search on all day-long 

opportunities at AMC. 

Registration Radio button to indicate if 

registration is required or 

not required for opportunity. 

Note that your selection will 

impact how many words are 

available to you in the 

magazine description field 

(longer entries are allowed 

when registration is not 

required.) 

Select the 

registration option 

that applies to this 

opportunity. 

Yes 

Archive on 

Expiration? 

This checkbox allows you to 

submit your opportunity to 

the archives for two years 

once it occurs. This means 

that you can retrieve and 

reactivate it in the future (re-

activate it and update the 

dates). This is helpful if you 

offer the same or a similar 

opportunity every year. 

The system default-

checks this box. If 

you do not wish this 

opportunity to be 

archived, uncheck 

the box. 

 

Short Web 

Description 

You may opt to skip this 

field if you like. Use of this 

description field is currently 

limited to the search results 

page for end web users. 

Hovering over a title will 

display this field. 

You may opt to skip 

this field. If you 

choose to populate it, 

enter a short 

summary of the 

opportunity. Word 

limit is 100 words. 

No 

Long Web 

Description 

This description of the 

opportunity is displayed on 

the web – both on chapter 

websites and on the main 

Enter up to 450 

words describing the 

opportunity. 

Yes, if 

opportunity 

is set to be 

published 
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Trip Entry 

Form 

Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

AMC website. on web. 

Magazine 

Description 

This description of the 

opportunity is displayed in 

AMC Outdoors and is 

available for use by 

volunteer newsletter editors 

for their publications. 

Enter up to 20 words 

describing the 

opportunity. If 

registration is not 

required, you may 

enter 40 words. If 

you exceed the 

prescribed limit you 

will be informed 

when you click away 

from the field. 

Yes, if trip 

is set to be 

published 

on web. 

Location Freeform text box to indicate, 

specifically, where your 

opportunity takes place. 

Entering a value in this field 

is usually helpful only if the 

opportunity takes place in a 

specific location or town that 

is distinct from the “Region” 

Enter the location 

where the 

opportunity takes 

place. E.g. Blue Hills 

Reservation, Valley 

Forge National Park, 

Central Park. 

No 

Region This dropdown value helps 

end users search on 

programs/trips/opportunities 

taking place in a particular 

region.  

Select the region in 

which the 

opportunity takes 

place. 

Yes 

State This dropdown box sets a  

value that helps end users 

search on 

programs/trips/opportunities 

taking place in a particular 

state 

This field auto-

populates based on 

your selection of a 

Region. If necessary, 

select the state in 

which the 

opportunity takes 

place. 

Yes 

Country This box displays the 

country in which the 

opportunity occurs. 

This field auto-

populates based on 

your selection of a 

Yes 
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Trip Entry 

Form 

Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

Region. If necessary, 

enter the country in 

which the 

opportunity takes 

place. 

Nearby 

AMC 

Destination 

This dropdown box sets a 

value that helps end users 

search on 

programs/trips/opportunities 

taking place near an AMC 

Destination, where the end 

user may be planning a trip.  

Select the AMC 

Destination near 

which the 

opportunity occurs, 

if any. You may 

select multiple 

entries from this list 

by holding the “Ctrl” 

button down while 

selecting multiples.  

No 

Audience Multi-select box to indicate 

for what audience your 

opportunity is geared. 

Select the 

appropriate option(s) 

from the select box. 

You may select 

multiple entries from 

this list by holding 

the “Ctrl” button 

down while selecting 

multiples. 

No 

Activity Dropdown box to indicate 

what activity is best 

associated with the 

opportunity. End web users 

will use these activities when 

searching to find trips that fit 

their activity interests. 

Select the activity 

that is most relevant 

to your opportunity. 

You may select 

multiple entries from 

this list by holding 

the “Ctrl” button 

down while selecting 

multiples. 

Yes 

Contact 

Information 

- Name 

This field displays the name 

of the leader on the web and 

in the magazine. 

Enter leader name 

(the field auto-

populates with trip 

Yes – Row 1 

only 



 

 v 2.0 39 

Trip Entry 

Form 

Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

contributor’s name – 

no action may be 

necessary). Note that 

Contact Information 

Row #1 is required so 

at least one leader’s 

name must be 

entered. 

Contact 

Information 

– Phone 

Number 

This field accepts a single 

phone number. If populated, 

the phone number will be 

printed in the magazine. The 

phone number will not be 

displayed on the web unless 

“Show Phone on Web” 

checkbox is checked (see 

below.) 

Enter leader’s phone 

number. 

Not if email 

address is 

entered 

instead – 

Row 1 only 

Contact 

Information 

– Time to 

Call 

Best time to call 

contributor/leader. If 

populated, the time to call 

will be printed in the 

magazine. Times to call will 

not be displayed on the web 

unless “Show Phone on 

Web” checkbox is checked 

(see below.) 

Enter the time(s) of 

day leader prefers to 

receive phone calls 

from prospective 

participants. 

No 

Contact 

Information 

– Show 

Phone on 

Web 

Flag to indicate if leader 

phone number/times to call 

is to be visible on the web. 

Check this if you’d 

like the phone 

number/times to call 

fields to be visible on 

the web. 

Not if email 

address is 

entered 

instead – 

Row 1 only 

Contact 

Information 

– Email 

Address 

This field accepts a single 

email address. If populated, 

the email address will be 

printed in the magazine. The 

email address will not be 

Enter trip leader’s 

email address (the 

field auto-populates 

with contributor’s 

email address – no 

Not if 

phone 

number is 

entered 

AND 
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Trip Entry 

Form 

Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

displayed on the web unless 

“Show Email on Web” 

checkbox is checked (see 

below.) If email address is 

entered and “Show Email on 

Web” is NOT checked, end 

web users may still contact 

leader via an anonymous 

web contact form. 

action may be 

necessary). 

“Show 

Phone on 

Web” is 

checked – 

Row 1 only 

Contact 

Information 

– Show 

Email on 

Web 

Flag to indicate if leader 

email address is to be visible 

on web. 

Check this if you’d 

like your email 

address to be visible 

to web users. Note: If 

email address is 

entered and “Show 

Phone on Web” is 

NOT checked, end 

web users may still 

contact leader via an 

anonymous web 

contact form. 

Not if 

phone 

number is 

entered 

AND 

“Show 

Phone on 

Web” is 

checked – 

Row 1 only 

Co-Contact 

Information 

Please refer to “Contact Information” information above for details 

on populating these fields with co-leader information. 

Registrar Please refer to “Contact Information” information above for details 

on populating these fields with Registrar information. If this 

information is populated, then “Registrar” will be displayed first 

on the web to indicate that they are the primary point of contact 

for the trip. Enter Address, City, State and ZIP if you are 

encouraging trip participants to send a check to the Registrar via 

U.S. Mail. This information will be published in the magazine and 

on the web. 

Website 

Posting 

Information 

– Web 

Release 

This field controls when 

your opportunity will be 

published live on the web 

once it passes approval. E.g. 

You may submit an August 

Enter the date you’d 

like the opportunity 

to appear on the web 

if not immediately. 

This field auto-

No 
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Trip Entry 

Form 

Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

Date opportunity during May, in 

which case it will be 

approved almost 

immediately. If you do not 

wish your opportunity to be 

available on the web until 

June, you’d enter 6/1/XX in 

this field. 

populates with 

today’s date, so no 

action may be 

necessary. 

Web End 

Date 

This field controls when 

your opportunity will be 

removed from the web. Note 

opportunities are removed 

from the web the day after 

they take place by default. 

E.g. For an opportunity 

taking place on 6/15/XX, you 

may wish to have the trip 

removed from the web on 

6/10/XX to discourage last-

minute signups. 

Enter the date you’d 

like the opportunity 

to be removed from 

the web, if at all. By 

default, the 

opportunity will be 

removed the day 

after it takes place. 

No 

Web Search 

Terms 

This field allows you to enter 

some key words or terms 

relevant to the opportunity 

that might help search 

engines “find” it and feature 

it in search result listings. 

Enter a handful of 

relevant keywords or 

phrases. 

No 

Link Text This field, in combination with “Link URL” allows 

you to add related links to your listing. Populate the 

link text field with a descriptive title for the link. E.g. 

“More Information on Blue Hills Reservation” 

You may add up to 6 related links. 

No 

Link URL This field, in combination with “Link Text” allows 

you to add related links to your listing. Populate the 

link URL field with the URL to which you’d like to 

direct web users for more information (minus the 

“http://”). E.g. 

No 
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Trip Entry 

Form 

Fields 

Defined 

What is this? What do I enter? Is this 

Required? 

“www.mass.gov/dcr/parks/metroboston/blue.htm 

You may add up to 6 related links. 

Notes This field allows you to send internal, administrative 

notes to other volunteer committee users in your 

approval queue. When your reviewer opens the trip 

for review, they will be able to see your notes. 

No 
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When you have completed data entry, click “Review” to move on to a 

confirmation screen. 
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Review the confirmation screen for accuracy. Use the “Edit” button to return to 

the volunteer opportunity entry screen to make changes. 

 

Contributors are also given the option to “Save/Edit Later” or “Submit & 

Forward to Reviewer”.  If you submit your opportunity, the reviewer will be 

automatically notified by email that your opportunity is waiting for review. 

Contributors have the ability to edit their opportunities up until the point a 

reviewer edits and approves it (see “Editing a Trip Listing Prior to Approval” on 

page 49 for additional detail on this – volunteer opportunities work similarly to 

trips in this instance). Once a reviewer has opened an opportunity to edit, that 

opportunity is no longer accessible to contributors for editing. 

 

After submitting one opportunity, you will return to the previous screen and see 

your new listing under “Current Events” with a status of “Contributor sent to 

Reviewer”.  You can also see the status of your other submissions.  Once your 

opportunity has gone through the complete review process by committee 

reviewer and chapter approver, the opportunity will be posted to the website 

and/or published in the magazine, based on your specifications. 

 

Note also that next to each opportunity under “Current Events,” several options, 

including “View Mag,” “View Web” and “Edit” exist.  
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The “view mag” button allows you to preview the opportunity the way it will be 

submitted to the AMC Outdoors editors.  

E.g. 

 
 

The “view web” button allows you to preview the opportunity the way it will 

appear online once approved.  
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E.g.  

 
 

 

The “edit” button will allow you to re-open the trip entry form to make any 

changes prior to the opportunity being reviewed. 
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Reusing an Archived Trip Listing 
To reuse a trip previously entered and archived, you must first log in, using your 

email address and assigned password. 

Once logged in, on the left navigation bar, you’ll find a central contributor 

administration area that will give you several options, including the ability to 

update your account information, add trips, add volunteer opportunities, and 

search current and archived trips. 

To reactivate an archived trip, use the “Search <Chapter> Events” option in the 

left navigation bar. 

In the “Show me” search box, select “Archived” in the first dropdown box. Then 

click on the “More options” link and select your current committee from the 

“Committee” dropdown box. Click the “Search” button. 

 

 

 

You will see a list of all archived trips run by your committee in the last two 

years. Use the top search box to narrow your criteria (e.g. by keyword or by 
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activity) or page through the search results to locate the trip you’d like to 

reactivate. Note, if you have many past trips in the system archives, you may 

narrow your results by using the “Only mine” checkbox – the system will 

retrieve only your archived trips. 

 

In the “Edit Options” column of the trip list, select “reactivate.” The screen will 

open to the “Edit Trip” page, with the trip’s date fields now empty. These date 

fields are able to changed so if the trip will occur in the future, you may make 

those changes accordingly. 

 

 
 

Note: When selecting “reactivate,” you are not actually reactivating the existing trip, but 

rather making a copy of the trip and publishing the new copy. 

 

You may refer to “Entering a New Trip Listing” for additional detail on the fields 

available for trip information entry. Once you are satisfied with the changes, you 

can click “Save & Forward to Reviewer” to process the trip. The information will 

then be processed in the same manner as a newly-entered trip. 
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Editing a Trip Listing Prior 

to Approval 

To edit a trip previously entered but saved for later editing (not yet approved), 

you must first log in, using your email address and assigned password. 

Once logged in, on the left navigation bar, you’ll find a central contributor 

administration area that will give you several options, including the ability to 

update your account information, add trips, add volunteer opportunities, and 

search current and archived trips. 

 
 

Under Current Events, find the trip you’d like to edit and select “edit” under 

Edit Options. (Note: the “edit” option will only be available if the Reviewer has not yet 

approved the trip.) The trip-editing page will open. 
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Make any additional changes (refer to “Entering a New Trip” for additional 

instruction on the available information fields) and either save to edit later or 

submit to reviewer, as usual. 
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Editing a Trip’s Status  

To edit a trip previously entered but saved for later editing (not yet approved), 

you must first log in, using your email address and assigned password. 

Once logged in, on the left navigation bar, you’ll find a central contributor 

administration area that will give you several options, including the ability to 

update your account information, add trips, add volunteer opportunities, and 

search current and archived trips. 

 
 

Under Current Trips, find the trip whose status you’d like to change and select 

“change status” under Edit Options. The “Current Trip’s Status” page will open. 
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Select the appropriate new status for the trip and click on “Change Status” to 

save the change. You’ll note this change is reflected immediately throughout the 

application and the new status will be immediately visible to other users. 

 

The “Cancel” button on this page will take you back to the central contributor 

administration area. 
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For Additional Support  

There are a number of ways to receive additional assistance in support of this 

system. 

 

A Yahoo Group has been set up and is being maintained in order that users may 

communicate with other users and AMC staff for the purpose of information 

exchange. Specific login information for joining and accessing this group will be 

distributed to each chapter individually. 

 

For additional questions, contact the AMC Web Production Associate at 

webeditor@outdoors.org or via phone, 617-391-6632.  

 

 

 


